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Abstract

Read this document for instructions about how to install and manage Red Hat OpenShift Data
Foundation using Red Hat OpenShift Container Platform on Microsoft Azure.
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MAKING OPEN SOURCE MORE INCLUSIVE

MAKING OPEN SOURCE MORE INCLUSIVE

Red Hat is committed to replacing problematic language in our code, documentation, and web
properties. We are beginning with these four terms: master, slave, blacklist, and whitelist. Because of the
enormity of this endeavor, these changes will be implemented gradually over several upcoming releases.
For more details, see our CTO Chris Wright's message.


https://www.redhat.com/en/blog/making-open-source-more-inclusive-eradicating-problematic-language
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PROVIDING FEEDBACK ON RED HAT DOCUMENTATION

We appreciate your input on our documentation. Do let us know how we can make it better.
To give feedback, create a Bugzilla ticket:

1. Go to the Bugzilla website.

2. In the Component section, choose documentation.

3. Fillin the Description field with your suggestion for improvement. Include a link to the relevant
part(s) of documentation.

4. Click Submit Bug.


https://bugzilla.redhat.com/enter_bug.cgi?product=Red Hat OpenShift Data Foundation

PREFACE

PREFACE

Red Hat OpenShift Data Foundation supports deployment on existing Red Hat OpenShift Container
Platform (RHOCP) Azure clusters.

NOTE

Only internal OpenShift Data Foundation clusters are supported on Microsoft Azure. See
Planning your deployment for more information about deployment requirements.

To deploy OpenShift Data Foundation, start with the requirements in Preparing to deploy OpenShift
Data Foundation chapter and then follow the appropriate deployment process based on your
requirement:

® Deploy OpenShift Data Foundation on Microsoft Azure

® Deploy standalone Multicloud Object Gateway component


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html/planning_your_deployment/index
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#preparing_to_deploy_openshift_data_foundation
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#deploy-standalone-multicloud-object-gateway
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CHAPTER 1. PREPARING TO DEPLOY OPENSHIFT DATA

FOUNDATION

Deploying OpenShift Data Foundation on OpenShift Container Platform using dynamic storage devices
provides you with the option to create internal cluster resources. This will result in the internal
provisioning of the base services, which helps to make additional storage classes available to
applications.

Before you begin the deployment of OpenShift Data Foundation, follow these steps:

1.

3.

Setup a chrony server. See Configuring chrony time service and use knowledgebase solution to
create rules allowing all traffic.

Optional: If you want to enable cluster-wide encryption using the external Key Management
System (KMS) HashiCorp Vault, follow these steps:

® Ensure that you have a valid Red Hat OpenShift Data Foundation Advanced subscription.
To know how subscriptions for OpenShift Data Foundation work, see knowledgebase article
on OpenShift Data Foundation subscriptions.

® When the Token authentication method is selected for encryption then refer to Enabling
cluster-wide encryption with the Token authentication using KMS.

® When the Kubernetes authentication method is selected for encryption then refer to
Enabling cluster-wide encryption with the Kubernetes authentication using KMS .

® Ensure that you are using signed certificates on your Vault servers.

NOTE

If you are using Thales CipherTrust Manager as your KMS, you will enable it
during deployment.

e

Minimum starting node requirements

An OpenShift Data Foundation cluster is deployed with minimum configuration when the
standard deployment resource requirement is not met. See Resource requirements section in
Planning guide.

Disaster recovery requirements [ Technology Preview]
Disaster Recovery features supported by Red Hat OpenShift Data Foundation require all of the
following prerequisites to successfully implement a disaster recovery solution:

® Avalid Red Hat OpenShift Data Foundation Advanced subscription

® Avalid Red Hat Advanced Cluster Management for Kubernetes subscription
To know how subscriptions for OpenShift Data Foundation work, see knowledgebase article
on OpenShift Data Foundation subscriptions.

For detailed requirements, see Configuring OpenShift Data Foundation Disaster Recovery for
OpenShift Workloads guide, and Requirements and recommendations section of the Install
guide in Red Hat Advanced Cluster Management for Kubernetes documentation.


https://access.redhat.com/documentation/en-us/openshift_container_platform/4.15/html/installing/installation-configuration#installation-special-config-chrony_installing-customizing
https://access.redhat.com/solutions/4863201
https://access.redhat.com/articles/6932811
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#enabling-cluster-wide-encryprtion-with-the-token-authentication-using-kms_azure
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#enabling-cluster-wide-encryprtion-with-the-kubernetes-authentication-using-kms_azure
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/planning_your_deployment/index#resource-requirements_rhodf
https://access.redhat.com/articles/6932811
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/configuring_openshift_data_foundation_disaster_recovery_for_openshift_workloads/index
https://access.redhat.com/documentation/en-us/red_hat_advanced_cluster_management_for_kubernetes/2.10/html/install/installing#requirements-and-recommendations
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CHAPTER 2. DEPLOYING OPENSHIFT DATA FOUNDATION
ON MICROSOFT AZURE

You can deploy OpenShift Data Foundation on OpenShift Container Platform using dynamic storage
devices provided by Microsoft Azure installer-provisioned infrastructure (IPI) (type: managed-csi) that
enables you to create internal cluster resources. This results in internal provisioning of the base services,
which helps to make additional storage classes available to applications.

Also, it is possible to deploy only the Multicloud Object Gateway (MCG) component with OpenShift
Data Foundation. For more information, see Deploy standalone Multicloud Object Gateway .

NOTE

Only internal OpenShift Data Foundation clusters are supported on Microsoft Azure. See
Planning your deployment for more information about deployment requirements.

Ensure that you have addressed the requirements in Preparing to deploy OpenShift Data Foundation
chapter before proceeding with the below steps for deploying using dynamic storage devices:

1. Install the Red Hat OpenShift Data Foundation Operator .

2. Create the OpenShift Data Foundation Cluster

2.1.INSTALLING RED HAT OPENSHIFT DATA FOUNDATION
OPERATOR

You can install Red Hat OpenShift Data Foundation Operator using the Red Hat OpenShift Container
Platform Operator Hub.

Prerequisites

® Access to an OpenShift Container Platform cluster using an account with cluster-admin and
operator installation permissions.

® You must have at least three worker or infrastructure nodes in the Red Hat OpenShift
Container Platform cluster.

® Foradditional resource requirements, see the Planning your deployment guide.

IMPORTANT

® When you need to override the cluster-wide default node selector for OpenShift
Data Foundation, you can use the following command to specify a blank node
selector for the openshift-storage namespace (create openshift-storage
namespace in this case):

I $ oc annotate namespace openshift-storage openshift.io/node-selector=

® Taint a node as infra to ensure only Red Hat OpenShift Data Foundation
resources are scheduled on that node. This helps you save on subscription costs.
For more information, see the How to use dedicated worker nodes for Red Hat
OpenShift Data Foundation section in the Managing and Allocating Storage
Resources guide.



https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#deploy-standalone-multicloud-object-gateway
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html/planning_your_deployment/index
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#preparing_to_deploy_openshift_data_foundation
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#installing-openshift-data-foundation-operator-using-the-operator-hub_azure
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/deploying_openshift_data_foundation_using_microsoft_azure/index#creating-an-openshift-data-foundation-service_azure
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/planning_your_deployment/index
https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/managing_and_allocating_storage_resources/index#how-to-use-dedicated-worker-nodes-for-openshift-data-foundation_rhodf
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Procedure
1. Login to the OpenShift Web Console.
2. Click Operators = OperatorHub.

3. Scroll or type OpenShift Data Foundation into the Filter by keyword box to find the
OpenShift Data Foundation Operator.

4. Click Install.
5. Set the following options on the Install Operator page:
a. Update Channel as stable-4.15.
b. Installation Mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-storage. If
Namespace openshift-storage does not exist, it is created during the operator installation.

d. Select Approval Strategy as Automatic or Manual.
If you select Automatic updates, then the Operator Lifecycle Manager (OLM)
automatically upgrades the running instance of your Operator without any intervention.

If you select Manual updates, then the OLM creates an update request. As a cluster
administrator, you must then manually approve that update request to update the Operator
to a newer version.

e. Ensure that the Enable option is selected for the Console plugin.

f. Click Install.

Verification steps

® After the operator is successfully installed, a pop-up with a message, Web console update is
available appears on the user interface. Click Refresh web console from this pop-up for the
console changes to reflect.

® |nthe Web Console:

o Navigate to Installed Operators and verify that the OpenShift Data Foundation Operator
shows a green tick indicating successful installation.

o Navigate to Storage and verify if the Data Foundation dashboard is available.

2.2. ENABLING CLUSTER-WIDE ENCRYPTION WITH KMS USING THE
TOKEN AUTHENTICATION METHOD

You can enable the key value backend path and policy in the vault for token authentication.

Prerequisites

® Administrator access to the vault.

® Avalid Red Hat OpenShift Data Foundation Advanced subscription. For more information, see
the knowledgebase article on OpenShift Data Foundation subscriptions.


https://access.redhat.com/articles/6932811
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e Carefully, select a unique path name as the backend path that follows the naming convention
since you cannot change it later.

Procedure

1. Enable the Key/Value (KV) backend path in the vault.
For vault KV secret engine AP, version 1:

I $ vault secrets enable -path=odf kv

For vault KV secret engine API, version 2:
I $ vault secrets enable -path=odf kv-v2

2. Create a policy to restrict the users to perform a write or delete operation on the secret:

echo'
path "odf/*" {
capabilities = ["create”, "read", "update”, "delete", "list"]

}

path "sys/mounts” {
capabilities = ["read"]
}'| vault policy write odf -

3. Create a token that matches the above policy:

I $ vault token create -policy=0df -format json

2.3. ENABLING CLUSTER-WIDE ENCRYPTION WITH KMS USING THE
KUBERNETES AUTHENTICATION METHOD

You can enable the Kubernetes authentication method for cluster-wide encryption using the Key
Management System (KMS).

Prerequisites

® Administrator access to Vault.

® Avalid Red Hat OpenShift Data Foundation Advanced subscription. For more information, see
the knowledgebase article on OpenShift Data Foundation subscriptions.

® The OpenShift Data Foundation operator must be installed from the Operator Hub.

® Select a unique path name as the backend path that follows the naming convention carefully.
You cannot change this path name later.

Procedure

1. Create a service account:

I $ oc -n openshift-storage create serviceaccount <serviceaccount_name>


https://access.redhat.com/articles/6932811
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where, <serviceaccount_names specifies the name of the service account.

For example:
I $ oc -n openshift-storage create serviceaccount odf-vault-auth

2. Create clusterrolebindings and clusterroles:

$ oc -n openshift-storage create clusterrolebinding vault-tokenreview-binding --
clusterrole=system:auth-delegator --serviceaccount=openshift-
storage:_<serviceaccount_name>_

For example:

$ oc -n openshift-storage create clusterrolebinding vault-tokenreview-binding --
clusterrole=system:auth-delegator --serviceaccount=openshift-storage:odf-vault-auth

3. Create a secret for the serviceaccount token and CA certificate.

$ cat <<EOF | oc create -f -
apiVersion: v1
kind: Secret
metadata:
name: odf-vault-auth-token
namespace: openshift-storage
annotations:
kubernetes.io/service-account.name: <serviceaccount_name>
type: kubernetes.io/service-account-token
data: {}
EOF

where, <serviceaccount_names is the service account created in the earlier step.

4. Get the token and the CA certificate from the secret.

$ SA_JWT_TOKEN=$(oc -n openshift-storage get secret odf-vault-auth-token -o jsonpath="
{.data['token']}" | base64 --decode; echo)

$ SA_CA_CRT=$(oc -n openshift-storage get secret odf-vault-auth-token -o jsonpath="
{.data['ca\.crt']}" | base64 --decode; echo)

5. Retrieve the OCP cluster endpoint.

I $ OCP_HOST=$(oc config view --minify --flatten -o jsonpath="{.clusters[0].cluster.server}")

6. Fetch the service account issuer:

$ oc proxy &

$ proxy_pid=$!

$ issuer="$( curl --silent http://127.0.0.1:8001/.well-known/openid-configuration | jq -r
.issuer)"

$ kill $proxy_pid

10
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7. Use the information collected in the previous step to setup the Kubernetes authentication
method in Vault:

I $ vault auth enable kubernetes

$ vault write auth/kubernetes/config \
token_reviewer_jwt="$SA_JWT_TOKEN"\
kubernetes_host="$OCP_HOST" \
kubernetes_ca_cert="$SA_CA_CRT"\
issuer="$issuer"

IMPORTANT

To configure the Kubernetes authentication method in Vault when the issuer is
empty:

$ vault write auth/kubernetes/config \
token_reviewer_jwt="$SA_JWT_TOKEN"\
kubernetes_host="$OCP_HOST" \
kubernetes_ca_cert="$SA_CA_CRT"

8. Enable the Key/Value (KV) backend path in Vault.
For Vault KV secret engine API, version 1:

I $ vault secrets enable -path=odf kv

For Vault KV secret engine API, version 2:
I $ vault secrets enable -path=odf kv-v2

9. Create a policy to restrict the users to perform a write or delete operation on the secret:

echo'
path "odf/*" {
capabilities = ["create”, "read", "update”, "delete", "list"]
1
path "sys/mounts” {
capabilities = ["read"]
}'| vault policy write odf -

10. Generate the roles:
$ vault write auth/kubernetes/role/odf-rook-ceph-op \
bound_service_account_names=rook-ceph-system,rook-ceph-osd,noobaa \
bound_service_account_namespaces=openshift-storage \
policies=odf \

ttl=1440h

The role odf-rook-ceph-op is later used while you configure the KMS connection details during
the creation of the storage system.

I $ vault write auth/kubernetes/role/odf-rook-ceph-osd \

1
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bound_service_account_names=rook-ceph-osd \
bound_service_account_namespaces=openshift-storage \
policies=odf \

ttl=1440h

2.4. CREATING AN OPENSHIFT DATA FOUNDATION CLUSTER

Create an OpenShift Data Foundation cluster after you install the OpenShift Data Foundation operator.

Prerequisites

® The OpenShift Data Foundation operator must be installed from the Operator Hub. For more
information, see Installing OpenShift Data Foundation Operator using the Operator Hub .

Procedure

1. In the OpenShift Web Console, click Operators = Installed Operatorsto view all the installed
operators.
Ensure that the Project selected is openshift-storage.

2. Click on the OpenShift Data Foundation operator, and then click Create StorageSystem.

3. In the Backing storage page, select the following:

a. Select Full Deployment for the Deployment type option.
b. Select the Use an existing StorageClass option.

c. Select the Storage Class.
By default, it is set to managed-csi.

d. Optional: Select Use external PostgreSQL checkbox to use an external PostgreSQL
[Technology preview].
This provides high availability solution for Multicloud Object Gateway where the
PostgreSQL pod is a single point of failure.

i. Provide the following connection details:

® Username
® Password
® Server nameand Port
® Database nhame
ii. Select Enable TLS/SSL checkbox to enable encryption for the Postgres server.
e. Click Next.

4. In the Capacity and nodes page, provide the necessary information:

a. Select a value for Requested Capacity from the dropdown list. It is set to 2 TiB by default.

12
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NOTE

Once you select the initial storage capacity, cluster expansion is performed
only using the selected usable capacity (three times of raw storage).

b. In the Select Nodes section, select at least three available nodes.

c. Inthe Configure performance section, select one of the following performance profiles:

® | ean
Use this in a resource constrained environment with minimum resources that are lower
than the recommended. This profile minimizes resource consumption by allocating
fewer CPUs and less memory.

® Balanced (default)
Use this when recommended resources are available. This profile provides a balance
between resource consumption and performance for diverse workloads.

® Performance
Use this in an environment with sufficient resources to get the best performance. This
profile is tailored for high performance by allocating ample memory and CPUs to
ensure optimal execution of demanding workloads.

NOTE

You have the option to configure the performance profile even after the
deployment using the Configure performance option from the options
menu of the StorageSystems tab.

IMPORTANT

Before selecting a resource profile, make sure to check the current
availability of resources within the cluster. Opting for a higher resource
profile in a cluster with insufficient resources might lead to installation
failures.

For more information about resource requirements, see Resource requirement for
performance profiles.

d. Optional: Select the Taint nodes checkbox to dedicate the selected nodes for OpenShift
Data Foundation.
For cloud platforms with multiple availability zones, ensure that the Nodes are spread
across different Locations/availability zones.

If the nodes selected do not match the OpenShift Data Foundation cluster requirements of
an aggregated 30 CPUs and 72 GiB of RAM, a minimal cluster is deployed. For minimum
starting node requirements, see the Resource requirements section in the Planning guide.

e. Click Next.

5. Optional: In the Security and network page, configure the following based on your
requirements:

a. To enable encryption, select Enable data encryption for block and file storage

i. Select either one or both the encryption levels:

13


https://access.redhat.com/documentation/en-us/red_hat_openshift_data_foundation/4.15/html-single/planning_your_deployment/index#resource-requirements-for-performance-profiles_rhodf
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® Cluster-wide encryption
Encrypts the entire cluster (block and file).

® StorageClass encryption
Creates encrypted persistent volume (block only) using encryption enabled storage
class.

ii. Optional: Select the Connect to an external key management servicecheckbox. This
is optional for cluster-wide encryption.

A. From the Key Management Service Providerdrop-down list, either select Vault
or Thales CipherTrust Manager (using KMIP). If you selected Vault, go to the next
step. If you selected Thales CipherTrust Manager (using KMIP), go to stepii.

B. Select an Authentication Method.
Using Token authentication method

® Enter a unique Connection Name, host Address of the Vault server
(‘https://<hostname or ip>"), Port number and Token.

® Expand Advanced Settings to enter additional settings and certificate
details based on your Vault configuration:

o Enter the Key Value secret path in Backend Path that is dedicated and
unique to OpenShift Data Foundation.

o Optional: Enter TLS Server Name and Vault Enterprise Namespace

o Upload the respective PEM encoded certificate file to provide the CA
Certificate, Client Certificate and Client Private Key .

o Click Save and skip to step iv.

Using Kubernetes authentication method

® Enter a unique Vault Connection Name, host Address of the Vault server
(‘https://<hostname or ip>"), Port number and Role name.

® Expand Advanced Settings to enter additional settings and certificate
details based on your Vault configuration:

o Enter the Key Value secret path in Backend Path that is dedicated and
unique to OpenShift Data Foundation.

o Optional: Enter TLS Server Name and Authentication Path if
applicable.

o Upload the respective PEM encoded certificate file to provide the CA
Certificate, Client Certificate and Client Private Key .

o Click Save and skip to step iv.

C. Touse Thales CipherTrust Manager (using KMIP) as the KMS provider, follow the
steps below:

14
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I. Enter a unique Connection Name for the Key Management service within the
project.

IIl. Inthe Address and Port sections, enter the IP of Thales CipherTrust Manager
and the port where the KMIP interface is enabled. For example:

® Address: 123.34.3.2
® Port: 5696
lll. Upload the Client Certificate, CA certificate, and Client Private Key.

IV. If StorageClass encryption is enabled, enter the Unique Identifier to be used for
encryption and decryption generated above.

V. The TLS Server field is optional and used when there is no DNS entry for the
KMIP endpoint. For example, kmip_all_<port>.ciphertrustmanager.local.

D. Select a Network.
E. Click Next.

b. To enable in-transit encryption, select In-transit encryption.

i. Select a Network.
ii. Click Next.

6. In the Data Protection page, if you are configuring Regional-DR solution for Openshift Data
Foundation then select the Prepare cluster for disaster recovery (Regional-DR only)
checkbox, else click Next.

7. In the Review and create page, review the configuration details.
To modify any configuration settings, click Back.

8. Click Create StorageSystem.

NOTE

When your deployment has five or more nodes, racks, or rooms, and when there are five
or more number of failure domains present in the deployment, you can configure Ceph
monitor counts based on the number of racks or zones. An alert is displayed in the
notification panel or Alert Center of the OpenShift Web Console to indicate the option to
increase the number of Ceph monitor counts. You can use the Configure option in the
alert to configure the Ceph monitor counts. For more information, see Resolving low
Ceph monitor count alert.

Verification steps
® To verify the final Status of the installed storage cluster:

a. Inthe OpenShift Web Console, navigate to Installed Operators = OpenShift Data
Foundation —» Storage System — ocs-storagecluster-storagesystem — Resources.

b. Verify that Status of StorageCluster is Ready and has a green tick mark next to it.

15
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® To verify that all components for OpenShift Data Foundation are successfully installed, see
Verifying your OpenShift Data Foundation deployment.

Additional resources

To enable Overprovision Control alerts, refer to Alerts in Monitoring guide.

16
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CHAPTER 3. VERIFYING OPENSHIFT DATA FOUNDATION
DEPLOYMENT

Use this section to verify that OpenShift Data Foundation is deployed correctly.

3.1. VERIFYING THE STATE OF THE PODS

Procedure

1. Click Workloads = Podsfrom the OpenShift Web Console.

2. Select openshift-storage from the Project drop-down list.

NOTE

If the Show default projectsoption is disabled, use the toggle button to list all
the default projects.

For more information on the expected number of pods for each component and how it varies
depending on the number of nodes, see Table 3.1, “Pods corresponding to OpenShift Data
Foundation cluster”.

3. Set filter for Running and Completed pods to verify that the following pods are in Running and
Completed state:

Table 3.1. Pods corresponding to OpenShift Data Foundation cluster

Component Corresponding pods

OpenShift Data Foundation Operator

e ocs-operator-* (1pod on any storage
node)

e ocs-metrics-exporter-* (1pod on any
storage node)

e odf-operator-controller-manager-*
(1 pod on any storage node)

e odf-console-* (1pod on any storage node)

e csi-addons-controller-manager-* (1
pod on any storage node)

Rook-ceph Operator rook-ceph-operator-*

(1 pod on any storage node)
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Component Corresponding pods

Multicloud Object Gatewa
: Y e noobaa-operator-* (1pod on any storage

node)

e nhoobaa-core-* (1pod on any storage
node)

e noobaa-db-pg-* (1 pod on any storage
node)

e noobaa-endpoint-* (1pod on any storage
node)

MON rook-ceph-mon-*

(3 pods distributed across storage nodes)
MGR rook-ceph-mgr-*
(1 pod on any storage node)

MDS rook-ceph-mds-ocs-storagecluster-
cephfilesystem-*

(2 pods distributed across storage nodes)

Csl
e cephfs

o csi-cephfsplugin-* (1pod on each
storage node)

o csi-cephfsplugin-provisioner-* (2
pods distributed across storage nodes)

e rbd

o csi-rbdplugin-* (1pod on each
storage node)

o csi-rbdplugin-provisioner-* (2 pods
distributed across storage nodes)

rook-ceph-crashcollector rook-ceph-crashcollector-*

(1 pod on each storage node)

OSD
e rook-ceph-osd-* (1 pod for each device)

e rook-ceph-osd-prepare-ocs-
deviceset-* (1 pod for each device)

18



CHAPTER 3. VERIFYING OPENSHIFT DATA FOUNDATION DEPLOYMENT

3.2. VERIFYING THE OPENSHIFT DATA FOUNDATION CLUSTERIS
HEALTHY

Procedure

1. In the OpenShift Web Console, click Storage —» Data Foundation.

2. In the Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.

3. In the Status card of the Block and File tab, verify that the Storage Cluster has a green tick.
4. In the Details card, verify that the cluster information is displayed.

For more information on the health of the OpenShift Data Foundation cluster using the Block and File
dashboard, see Monitoring OpenShift Data Foundation.

3.3. VERIFYING THE MULTICLOUD OBJECT GATEWAY IS HEALTHY

Procedure

1. In the OpenShift Web Console, click Storage —» Data Foundation.

2. Inthe Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.

a. Inthe Status card of the Object tab, verify that both Object Service and Data Resiliency
have a green tick.

b. In the Details card, verify that the MCG information is displayed.

For more information on the health of the OpenShift Data Foundation cluster using the object service
dashboard, see Monitoring OpenShift Data Foundation.

3.4.VERIFYING THAT THE SPECIFIC STORAGE CLASSES EXIST

Procedure

1. Click Storage — Storage Classesfrom the left pane of the OpenShift Web Console.

2. Verify that the following storage classes are created with the OpenShift Data Foundation
cluster creation:

e ocs-storagecluster-ceph-rbd
e ocs-storagecluster-cephfs

e openshift-storage.noobaa.io
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CHAPTER 4. DEPLOY STANDALONE MULTICLOUD OBJECT
GATEWAY

Deploying only the Multicloud Object Gateway component with OpenShift Data Foundation provides
the flexibility in deployment and helps to reduce the resource consumption. Use this section to deploy
only the standalone Multicloud Object Gateway component, which involves the following steps:

® |nstalling Red Hat OpenShift Data Foundation Operator

® Creating standalone Multicloud Object Gateway

4.1. INSTALLING RED HAT OPENSHIFT DATA FOUNDATION
OPERATOR

You can install Red Hat OpenShift Data Foundation Operator using the Red Hat OpenShift Container
Platform Operator Hub.

Prerequisites

® Access to an OpenShift Container Platform cluster using an account with cluster-admin and
operator installation permissions.

® You must have at least three worker or infrastructure nodes in the Red Hat OpenShift
Container Platform cluster.

® For additional resource requirements, see the Planning your deployment guide.

IMPORTANT

® When you need to override the cluster-wide default node selector for OpenShift
Data Foundation, you can use the following command to specify a blank node
selector for the openshift-storage namespace (create openshift-storage
namespace in this case):

I $ oc annotate namespace openshift-storage openshift.io/node-selector=

® Taint a node as infra to ensure only Red Hat OpenShift Data Foundation
resources are scheduled on that node. This helps you save on subscription costs.
For more information, see the How to use dedicated worker nodes for Red Hat
OpenShift Data Foundation section in the Managing and Allocating Storage
Resources guide.

Procedure

1. Login to the OpenShift Web Console.
2. Click Operators = OperatorHub.

3. Scroll or type OpenShift Data Foundation into the Filter by keyword box to find the
OpenShift Data Foundation Operator.

4. Click Install.

5. Set the following options on the Install Operator page:
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a. Update Channel as stable-4.15.
b. Installation Mode as A specific namespace on the cluster

c. Installed Namespace as Operator recommended namespace openshift-storage. If
Namespace openshift-storage does not exist, it is created during the operator installation.

d. Select Approval Strategy as Automatic or Manual.
If you select Automatic updates, then the Operator Lifecycle Manager (OLM)
automatically upgrades the running instance of your Operator without any intervention.

If you select Manual updates, then the OLM creates an update request. As a cluster
administrator, you must then manually approve that update request to update the Operator
to a newer version.

e. Ensure that the Enable option is selected for the Console plugin.

f. Click Install.

Verification steps

® After the operator is successfully installed, a pop-up with a message, Web console update is
available appears on the user interface. Click Refresh web console from this pop-up for the
console changes to reflect.

® |nthe Web Console:

o Navigate to Installed Operators and verify that the OpenShift Data Foundation Operator
shows a green tick indicating successful installation.

o Navigate to Storage and verify if the Data Foundation dashboard is available.

4.2. CREATING ASTANDALONE MULTICLOUD OBJECT GATEWAY

You can create only the standalone Multicloud Object Gateway component while deploying OpenShift
Data Foundation.

Prerequisites

® Ensure that the OpenShift Data Foundation Operator is installed.

Procedure

1. In the OpenShift Web Console, click Operators — Installed Operators to view all the installed
operators.
Ensure that the Project selected is openshift-storage.

2. Click OpenShift Data Foundation operator and then click Create StorageSystem.

3. In the Backing storage page, select the following:

a. Select Multicloud Object Gateway for Deployment type.
b. Select the Use an existing StorageClass option.

c. Click Next.
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4. Optional: Select the Connect to an external key management servicecheckbox. This is
optional for cluster-wide encryption.

a. From the Key Management Service Providerdrop-down list, either select Vault or Thales
CipherTrust Manager (using KMIP). If you selected Vault, go to the next step. If you
selected Thales CipherTrust Manager (using KMIP), go to step iii.

b. Select an Authentication Method.
Using Token authentication method

® Enter a unique Connection Name, host Address of the Vault server
(‘https://<hostname or ip>"), Port number and Token.

® Expand Advanced Settings to enter additional settings and certificate details
based on your Vault configuration:

o Enter the Key Value secret path in Backend Path that is dedicated and unique
to OpenShift Data Foundation.

o Optional: Enter TLS Server Name and Vault Enterprise Namespace

o Upload the respective PEM encoded certificate file to provide the CA
Certificate, Client Certificate and Client Private Key .

o Click Save and skip to step iv.

Using Kubernetes authentication method

® Enter a unique Vault Connection Name, host Address of the Vault server
(‘https://<hostname or ip>"), Port number and Role name.

® Expand Advanced Settings to enter additional settings and certificate details
based on your Vault configuration:

o Enter the Key Value secret path in Backend Path that is dedicated and unique
to OpenShift Data Foundation.

o Optional: Enter TLS Server Name and Authentication Pathif applicable.

o Upload the respective PEM encoded certificate file to provide the CA
Certificate, Client Certificate and Client Private Key .

o Click Save and skip to step iv.

c. To use Thales CipherTrust Manager (using KMIP) as the KMS provider, follow the steps
below:

i. Enter a unique Connection Name for the Key Management service within the project.

ii. Inthe Addressand Port sections, enter the IP of Thales CipherTrust Manager and the
port where the KMIP interface is enabled. For example:

® Address: 123.34.3.2
® Port: 5696

iii. Upload the Client Certificate, CA certificate, and Client Private Key.
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iv. If StorageClass encryption is enabled, enter the Unique Identifier to be used for
encryption and decryption generated above.

v. The TLS Server field is optional and used when there is no DNS entry for the KMIP
endpoint. For example, kmip_all_<port>.ciphertrustmanager.local.

d. Select a Network.
e. Click Next.

5. In the Review and create page, review the configuration details:
To modify any configuration settings, click Back.

6. Click Create StorageSystem.

Verification steps
Verifying that the OpenShift Data Foundation cluster is healthy

1. In the OpenShift Web Console, click Storage —» Data Foundation.

2. In the Status card of the Overview tab, click Storage System and then click the storage
system link from the pop up that appears.

a. Inthe Status card of the Object tab, verify that both Object Service and Data Resiliency
have a green tick.

b. In the Details card, verify that the MCG information is displayed.

Verifying the state of the pods

1. Click Workloads = Pods from the OpenShift Web Console.

2. Select openshift-storage from the Project drop-down list and verify that the following
pods are in Running state.

NOTE

If the Show default projectsoption is disabled, use the toggle button to list
P all the default projects.

Component Corresponding pods

OpenShift Data
Foundation Operator

L

e ocs-operator-* (1pod on any storage node)
e ocs-metrics-exporter-* (1 pod on any storage node)

e odf-operator-controller-manager-* (1pod on any storage
node)

e odf-console-* (1pod on any storage node)

e csi-addons-controller-manager-* (1pod on any storage
node)
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Component Corresponding pods

Rook-ceph Operator rook-ceph-operator-*

(1 pod on any storage node)

Multicloud Object

*
Gateway e noobaa-operator-* (1 pod on any storage node)

e nhoobaa-core-* (1pod on any storage node)
e noobaa-db-pg-* (1 pod on any storage node)

e noobaa-endpoint-* (1pod on any storage node)



CHAPTER 5. VIEW OPENSHIFT DATA FOUNDATION TOPOLOGY

CHAPTER 5. VIEW OPENSHIFT DATA FOUNDATION
TOPOLOGY

The topology shows the mapped visualization of the OpenShift Data Foundation storage cluster at
various abstraction levels and also lets you to interact with these layers. The view also shows how the
various elements compose the Storage cluster altogether.

Procedure

1. On the OpenShift Web Console, navigate to Storage = Data Foundation = Topology.
The view shows the storage cluster and the zones inside it. You can see the nodes depicted by
circular entities within the zones, which are indicated by dotted lines. The label of each item or
resource contains basic information such as status and health or indication for alerts.

2. Choose a node to view node details on the right-hand panel. You can also access resources or
deployments within a node by clicking on the search/preview decorator icon.

3. To view deployment details

a. Click the preview decorator on a node. A modal window appears above the node that
displays all of the deployments associated with that node along with their statuses.

b. Click the Back to main viewbutton in the model’s upper left corner to close and return to
the previous view.

c. Select a specific deployment to see more information about it. All relevant data is shown in
the side panel.

4. Click the Resources tab to view the pods information. This tab provides a deeper
understanding of the problems and offers granularity that aids in better troubleshooting.

5. Click the pod links to view the pod information page on OpenShift Container Platform. The link
opens in a new window.
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CHAPTER 6. UNINSTALLING OPENSHIFT DATA FOUNDATION

6.1. UNINSTALLING OPENSHIFT DATA FOUNDATION IN INTERNAL
MODE

To uninstall OpenShift Data Foundation in Internal mode, refer to the knowledge base article on
Uninstalling OpenShift Data Foundation.
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